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2

testo 6600 probes

2.1 Specifications
2.1.1 Functions and use
The plug-in, adjusted probes from the testo 6600 range are used in
conjunction with the testo 6651 humidity transmitter.
These measuring units are suitable for the following applications, for
example:





Process instrumentation
Test benches
Production and storage air quality
Complex room climate applications

2.1.1.1

Digital probes:

The probes are adjusted in the factory and transmit their adjustment data to
the internal memory of the testo 6651 transmitter. The information is
transmitted between the probe and transmitter in a purely digital form. The
probes can therefore be disconnected from the transmitter for adjustment or
servicing while the transmitter itself can remain at the measuring point.
Hint:
We recommend in this case that a probe of the same type be
inserted into the transmitter immediately in order to be able to
continue measuring with minimal interruption.
The transmitter identifies the probe and records that a probe was connected
in the history.
The testo 6651 transmitter cannot be run with the testo 6610
probes; testo 6600 probes must be used.
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2.1.1.2

The Testo humidity sensor

With the Testo humidity sensor, which has been in successful use and
continually improved for more than ten years, the focus has from the very
beginning been on both accuracy parameters, namely measuring uncertainty
and long-term stability.
The capacitive humidity sensor is in principle a plate capacitor consisting of
two electrically conductive plates (electrodes (1) and (2), see diagram below)
opposite each other.
A humidity-sensitive polymer (5) serves as the dielectric. The special feature
lies in the perfect way the individual layers are matched to each other. This is
evident particularly in the top electrode, which has to perform two tasks that,
at first glance, appear contradictory: it must be completely permeable to the
water vapour that is to be fed into the polymer dielectric, but at the same time
it must be impervious, smooth and repellent to condensate, oil and dirt in
order to protect the sensor.
1
2
3
4
5

Cover electrode
Bottom electrode
Substrate
(Ceramic substrate for
mechanical protection)
Connections
(protected against corrosion)
Dielectric layer
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2.1.1.3

Self-diagnosis

The probes in the testo 6600 range monitor their functionality themselves and
report the following faults:











Sensor breaks
Sensor short-circuit
Condensation
The condensation message is issued at a reading of 100 % RH and
deactivated once the readings are within the valid range.
Error message with drift at the adjustment points
Value for relative humidity less than 0 % RH.
The trigger threshold is set at -2 % RH. This means that an error
message is only issued once a clear effect is discernible.
Adjustment monitoring with and without PC
Operating hours
Excess temperature
Error message if the permissible process temperature is exceeded

2.1.2 Probe assembly
The probes of the testo 6600 range are made up of the following components
(included in delivery):





Probe connector
Probe shaft with protection cap and sensors (% RH and °C or °F)
Mounting bracket (for testo 6602/6603 duct version)
Probe cable (testo 6602 to 6605 duct and cable versions),
bend radius minimum Ø 50 mm.
Probe length

Probe connector
Probe

Protection cap, sensor underneath

probe
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2.1.3 Accessories
The following accessories are available for probes in the testo 6600 range:



Filters and protection caps (see chapter 2.2.1.4, page 94)
Calibration certificate in accordance with ISO and DAkkS (see chapter
4.2, page 149).

2.2 Product description
2.2.1 Overview of probe and filter types
2.2.1.1

Probe version
A detailed description of the probe versions can be found
from chapter 2.2.2, testo 6601 wall probe, page 94.

The following probe versions are available for the testo 6651 humidity
transmitter:
probe

Article no.

Characteristic

testo 6601

0555 6600-L01

Wall probe version; accuracy to ± 1,7 % RH;
temperature range -20 °C to +70 °C/-4 to +158 °F,
Sensor plugged

testo 6602

0555 6600-L02

Duct probe version; accuracy to ± 1.7 % RH;
temperature range -20 °C to +70 °C/-4 to +158 °F,
Sensor plugged

testo 6603

0555 6600-L03

Duct probe version; accuracy to ± 1,7 % RH;
temperature range -30 °C to +120°C/-22 to +248 °F,
Sensor plugged

testo 6604

0555 6600-L04

Cable probe version; accuracy to ± 1.7 % RH;
temperature range -20 °C to +70 °C/-4 to +158 °F,
Sensor plugged

testo 6605

0555 6600-L05

Cable probe version; accuracy to ± 1.7 % RH;
temperature range -30 °C to +120°C/-22 to +248 °F,
Sensor plugged
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2.2.1.2

Determining the accuracy/measuring uncertainty

The entries for the measuring uncertainty for the probe are determined in
accordance with GUM (Guide to the Expression of Uncertainty in
Measurement/DIN V ENV 13005). All parts that make up the measuring
uncertainty given by Testo are listed below. When comparing the measuring
uncertainty/accuracy between manufacturers, which components are
included is to be taken into account. In many cases, not all elements that
contribute to measuring uncertainty are assessed, for example if the error
contribution of the production adjustment is shown separately or not at all.
The measuring uncertainty of the probe includes the sensor and its
electronics as well as the output of the digital measuring signal:
1. Linearity including scatter

Systematic error and scattering of the
components (due to manufacturing
tolerances)

2. Hysteresis

Hysteresis indicates the maximum
deviation of the readings that are
obtained when you set the same value for
the parameter, once coming from a
smaller value, once coming from a larger
value (humidity sensors actually have no
hysteresis, but rather very slow
adjustment effects that appear to be
hysteresis when considered only for a
short period.)

3. Reproducibility

Repeatability (scattering of the readings
in the event of the same parameter being
entered successively)

4. Production adjustment area

The measuring uncertainty of the
adjustment area (including the reference
instrument) in production

5. Uncertainty of the testing

Uncertainty of the procedure for
determining points 1 and 2.
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2.2.1.3

Ordering options for testo 6600 probes
(0555 6600)

Order code

Characteristic

Lxx Probe type
L 01

Probe 6601

L 02

Probe 6602

L 03

Probe 6603

L 04

Probe 6604

L 05

Probe 6605

Mxx Protective
filter
M 01

Stainless steel sintered filter

M 02

Metal wire protection cap

M 03

Sintered PTFE filter

M 04

Open metal protection cap

M 05

ABS plastic cap (open)

Nxx Cable length
N 00

Without cable (testo 6601)

N 01

1 m cable length (testo 6604, 6605)

N 02

2 m cable length (testo 6604, 6605)

N 05

5 m cable length (testo 6605)

N 23

Cable length specifically for duct versions (testo 6602, 6603)

Pxx Probe length
P 07

Probe length approx. 70 mm (testo 6601)

P 14

Probe length approx. 140 mm (testo 6604)

P 20

Probe length approx. 200 mm (testo 6601, 6605)

P 28

Probe length approx. 280 mm (testo 6602, 6603, 6604)

P 50

Probe length approx. 500 mm (testo 6605)
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2.2.1.4

Filters

One of the following filters or protection caps can be used for each probe
version:
Filter* Article no.**

Characteristic

Length A (mm)

M 01

0554 0647

Stainless steel sintered filter

33

M 02

0554 0757

Metal wire protection cap

40,3

M 03

0554 0759

Sintered PTFE filter

35

M 04

0554 0755

Open metal protection cap

35

M 05

0192 0265

Open ABS plastic cap

25

*
**

When ordering the probe, please use this filter code (see chapter 2.2.1.3,
Ordering options for testo 6600 probes (0555 6600), page 93.
When purchasing a replacement (filters only), please use this order number.

2.2.2 testo 6601 wall probe
The wireless testo 6601 probe is inserted into the testo 6651 humidity
transmitter that is mounted on the wall and ready-wired.
At a glance
1
2
3
4

Filter (including: humidity
and temperature sensor)
Probe shaft
Key
Connector

In the event of overpressures, the probe may become a
projectile.
For assembly, see Pressure resistance on the following
page.
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Application

Monitoring and regulating the production and storage air quality when
manufacturing and storing hygroscopic products.

testo 6651 transmitter

testo 6601 wall probe

Technical Data
Parameters
- Humidity (% RH/°Ctd/°Ftd), etc.
- Temperature

-

Measuring range
- Humidity:
0 ... 100 % RH
- Temperature: - 20 ... 70 °C/-4 to
+158 °F

-

Material
- Probe shaft: ABS plastic
- Connector: ABS plastic
Accuracy (at 25 °C/77°F)*
- Humidity
- Length 200 mm
- ± (1.7 % RH + 0.007 x reading) for
0 to 90 % RH
- ± (1.9 % RH + 0.007 x reading) for
90 to 100 % RH
- 0.02 % RH/K, dependent upon the
process temperature
(with a deviation of ± 25 °C/+77 °F)

-

*

-

-

0.02 % RH/K, dependent upon the
electronics temperature
(with a deviation of 25 °C/+77 °F)
Temperature
±0.2 °C (±0.38 °F)
Slope PT1000 class A
Refer to the charts below for the
correlation between temperature
and accuracy.
Length 70 mm
As with length of 200 mm, but with
additional measuring error,
specified for the operating mode
2 channels at 12 mA, without
display light, relay off:
Humidity: ±1.6 % RH (additional)
Temperature: ±0.6 °C / ±1.1 °F
(additional)

Reproducibility
- Better than ±0.2 % RH
Sensor
Response time without protective filter:
t 90 max. 15 sec.
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Probe dimensions
- Diameter of probe shaft: 12 mm
- E = 55 mm
- L = approx. 70 mm or 200 mm
- L – A = 35 mm or 165 mm
- A (see Table Filters, chapter
2.2.1.4, page 94).

Pressure resistance
1 bar positive pressure (probe tip) **
*
Refer to the charts below for the
correlation between temperature
and accuracy.
** If installing probe under pressure,
please use cutting ring screw
connection (order no. 0554 1795).
-

Measuring accuracy of testo 6601 wall probe
Humidity error according to amount |±% RH| as a factor of process humidity
% RH

% RH
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Temperature error as a factor of process temperature and temperature of
electronics

System error 6651 + probe, electronics 25 °C/+77 °F
System error 6651 + probe, electronics -25 °C to +70 °C/-13 to +158 °F
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2.2.3 testo 6602/6603 duct probe
The testo 6602/6603 probe measures the humidity and temperature in air
ducts.
At a glance

1
2
3
4
5
6
7

Filter (including: humidity
and temperature sensor)
Probe shaft
Wall/duct holder
(accessories,
Order no.: 0554 6651)
Mounting bracket
(permanently joined to
probe shaft)
Probe cable
Key
Connector

In the event of overpressures, the probe may become a
projectile.
For assembly, see Pressure resistance on the following
page.
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Application

Continuous measurement of humidity and temperature in air duct
applications

Monitoring and regulating the production and storage air quality in air
ducts when manufacturing and storing hygroscopic products.
testo 6651 transmitter

testo 6602/6603 duct probe

Technical Data
Parameters
- Humidity: (% RH/°Ctd/°Ftd), etc.
- Temperature
Measuring range
- Humidity:
0 ... 100 % RH
- Temperature for
6602: -20 ... +70 °C/-4 to +158 °F 6603: - 30 ... +120 °C/-22 to
+248 °F
Material
- Probe shaft: Plastic PA66GF30
- Line: Sheathed, FEP
- Connector: ABS plastic
Accuracy (at 25 °C/77°F)*
Humidity
- ± (1.7 % RH + 0.007 x reading) for
0 to 90 % RH

± (1.9 % RH + 0.007 x reading) for
90 to 100 % RH
- 0.02 % RH/K, dependent upon the
process temperature
(with a deviation of 25 °C/+77 °F)
- 0.02 % RH/K, dependent upon the
electronics temperature
(with a deviation of 25 °C/+77 °F)
Temperature
- ±0.2 °C (±0.38 °F)
Slope PT1000 class A
-

Reproducibility
- Better than ±0.2 % RH
Sensor
Response time without protective
filter: t 90 max. 15 sec.
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Probe dimensions
- Diameter of probe shaft: 12 mm
- L = 280 mm
- L – A = 245 mm
- A (see Table Filters, chapter
2.2.1.4, page 94).
Cable length incl. probe shaft and
filter
- Customized for duct version

Pressure resistance
1 bar positive pressure (probe tip)
**
*
Refer to the charts below for the
correlation between temperature
and accuracy.
** If installing probe under pressure,
please use cutting ring screw
connection (order no. 0554 1796).
-

Measuring accuracy of testo 6602/6603 duct probe
Humidity error according to amount |±% RH| as a factor of process humidity
% RH

% RH
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Temperature error as a factor of process temperature and temperature of
electronics

System error 6651 + probe, electronics 25 °C/+77 °F
System error 6651 + probe, electronics -25 °C to +70 °C/-13 to
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2.2.4 testo 6604/6605 cable probe
The testo 6604/6605 probes are used when the spatial separation of the
transmitter and probe is required.
At a glance
1

4

5

2

3

1
2
3
4
5

Connector
Key
Probe cable
Probe shaft
Filter (including: humidity
and temperature sensor)

In the event of overpressures, the probe may become a
projectile.
For assembly, see Pressure resistance on the following
page.
Application

Monitoring and regulating industrial humidity processes (apart from
high-humidity processes), e.g. food production

Monitoring the production and storage air quality when manufacturing
and storing hygroscopic products.
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testo 6651 transmitter

testo 6604/6605 cable probe

Technical Data
Parameters
- Humidity: (% RH/°Ctd/°Ftd)
- Temperature
Measuring range
- Humidity:
0 ... 100 % RH
- Temperature for
6604: -20 ... +70 °C/-4 to +158 °F 6605: - 30 ... +120 °C/-22 to +248
°F
Material
- Probe shaft for
6604: Plastic PA66GF30
6605: Stainless steel
- Line: Sheathed, FEP
- Connector: ABS plastic
Accuracy (at 25 °C/77 °F)*
Humidity
- ± (1,7 % RH + 0.007 x reading) for
0 to 90 % RH
- ± (1.9 % RH + 0.007 x reading) for
90 to 100 % RH
- 0.02 % RH/K, dependent upon the
process temperature
(with a deviation of 25 °C/+77 °F)

0.02 % RH/K, dependent upon the
electronics temperature
(with a deviation of 25 °C/+77 °F)
Temperature
- 6604: ±0.2 °C (±0.38 °F)
- 6605: ±0,15 °C / ±0,27 °F
6604: Slope PT1000 class A
6605: Slope PT1000 class AA
-

Reproducibility
- Better than ±0.2 % RH
Sensor
Response time without protective
filter: t 90 max. 15 sec.
Probe dimensions
- Diameter of probe shaft: 12 mm
- L = 6604 140/280 mm
L = 6605 200/500 mm
- L – A = 6604 105 mm/245 mm
- L – A = 6605 165 mm/465 mm
- A, see Table Filters, chapter
2.2.1.4, page 94.

104 testo 6600 - 2.2 Product description

Probe length incl. probe shaft and
filter
- 1/2/5 m

Pressure resistance**
testo 6604: 1 bar positive pressure
(probe tip)
- testo 6605: PN 10 (probe tip)
*
Refer to the charts below for the
correlation between temperature
and accuracy.
** testo 6604: If installing probe
under pressure, please use PTFE
ring screw connection (order no.
0554 1796).
testo 6605: If installing probe
under pressure, please use
cutting ring screw connection
(order no. 0554 1795).
-

Measuring accuracy of testo 6604/6605 cable probe
Humidity error according to amount |±% RH| as a factor of process humidity
% RH

% RH
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Temperature error as a factor of process temperature and temperature of
electronics

System error 6651 + probe, electronics 25 °C/+77 °F
System error 6651 + probe, electronics -25 °C to +70 °C/-13 to
°

2.3 Commissioning
2.3.1 Installing the probe
2.3.1.1

Installing the testo 6601 wall probe

The testo 6601 probe (wall version) simply has to be inserted into the socket
of the testo 6651 transmitter.

2.3.1.2

Install testo 6602/6603 duct probe

A description of the duct mounting of the testo 6602/6603 probe can be found
in volume 1, chapter 1.3.2.2, Duct mounting (for testo 6602/6603 probes),
page 21.

2.3.1.3
Install testo 6604/6605 duct probe
 If used with these probes, the testo 6651 transmitter is mounted on the
wall (see volume 1, chapter 1.3.2.1, page 19).

▪

Install probe according to the application and the measuring and
spatial conditions.
In processes with which condensate forms at the humidity
probe, install the probe vertically (filter points downwards).
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A

Wall mounting of probe

Order no. 0554 6651

B

Duct mounting of probe
Snap transmitter onto the bracket at the
end of the duct probe.
Hole  12.5 mm

Wall/duct holder
(Order no. 0554 6651)

Atmospheric processes only. Alternatively, the single-hole duct holder
(order no. 0554 1793) can also be used.

Single-hole duct holder
Order no. 0554 1793
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C

Process mounting

Cutting ring screw connection
Order no. 0554 1795 for testo 6605 probe
Order no. 0554 1796 for testo 6604 probe

▪

During installation, ensure that the probe cannot be damaged during
operation.

2.3.2 Connecting/removing the probe to/from
the transmitter
▪
▪

Insert probe connector into socket of testo 6651 until it engages. The
testo 6651 identifies which probe is connected.
To remove the probe, the lock release button on the probe must be
pressed so that this can be removed.
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2.4 Maintenance and cleaning
2.4.1 Replacing filters/protection caps
2.4.1.1

Replacing the filter/protection cap for testo 6601
wall version

1
2

Do not damage the sensors when exchanging the filter/the
protection cap and do not touch their surfaces!

1
2

Carefully unscrew defective filter/protection cap (2) from probe shaft
(1).
Carefully screw new filter/protection cap onto probe shaft.
Screw on protection cap by hand, i.e. do not tighten it using a
tool.
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2.4.1.2

Replacing the filter/protection cap for
testo 6602/6603 duct version

Do not damage the sensors when exchanging the filter/the
protection cap and do not touch their surfaces!

Hint:
Mark the insertion length of the probe shaft near the screw
(11).
1
2

Undo screw (11) and pull shaft probe (9) together with filter/protection
cap (10) from the wall/duct holder (6).
Carefully unscrew defective filter/protection cap from probe shaft and
carefully screw on new filter/protection cap.
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Screw on protection cap by hand, i.e. do not tighten it using a
tool.

3

Replace O-ring (7) if necessary. Push probe shaft into duct as far as
the marking and fix position with screw (11).

2.4.1.3

Replacing the filter/protection cap for
testo 6604/6605 cable version

1

2

Do not damage the sensor when exchanging the filter/the
protection cap and do not touch its surface!

1
2

Carefully unscrew defective filter/protection cap (2) from probe shaft
(1).
Carefully screw new filter/protection cap onto probe shaft.
Screw on protection cap by hand, i.e. do not tighten it using a
tool.
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2.4.2 Cleaning the instrument and
filter/protection cap
▪
▪
▪
▪

Only clean the instrument carefully with a moist cloth.
Do not use aggressive cleaning agents.
Do not use any solvents.
Unscrew cap or protection cap to clean, clean with compressed air
and replace. Take care not to damage the sensor!

2.4.3 Replacing the sensors
It is not possible to replace the sensors with testo 6605.

As a result of the sensor concept, all sensors (except testo 6605) can be
replaced as needed. In the process, all of the following steps must be
adhered to.
1
2
3

Carefully unscrew filter/protection cap from probe shaft.
Remove defective sensor from slot with pincers.
Install new sensor in the slot.
During replacement, do not damage the sensor and do not
touch its surface! Contamination and the smallest damages
lead to incorrect measurement results.

4

Carefully screw filter/protection cap onto probe shaft.
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Screw on protection cap by hand, i.e. do not tighten it using a
tool.

To ensure the accuracy of the sensors,
- The humidity probe should then be adjusted using the
control
and adjustment set or in a humidity calibrator.
- The temperature should be adjusted using an appropriate
reference.
The adjustment can also be performed by your Testo
Service.
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3

Parameterizing,
adjusting and analyzing
software (P2A software)

3.1 Specifications
The P2A software is used for the parameterizing, adjustment and analysis of
testo transmitters. The following applies:





Generally, all newer testo transmitters (as of 2007) are supported.
Included with every testo transmitter that is bought new is a CD that
contains a free upgrade of the software, which includes the device
drivers for all transmitters that can be attached at this time.
This upgrade can be downloaded at any time via the testo homepage
"www.testo.com/Download/P2A".

The software must only be bought one time, even for owners of several testo
transmitters.

3.1.1

Functions and use

In the P2A software, two different file types are used: The instrument and the
parameter file.
Instrument file
The parameters of a particular transmitter are stored in its so-called
instrument file. Using this file, the parameters can be edited and the
instrument can be tested and adjusted.
Instrument files also contain the respective histories in addition to the
parameter data, i.e. "log books" are kept for the previous parameterizations,
adjustments and messages (see chapter 3.3.5, page 142).
Instrument files are ".cfm" format files.
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Parameter file
Parameter files are not tied to a specific individual transmitter and contain
only parameter data/no history data.
If you use various instruments of the same type, you can create parameter
files once (e.g. by saving the appropriate instrument file as the parameter file)
and transmit these onto the other instruments.
Parameter files are ".cfp" format files.

3.1.2

System requirements

Operating system

Windows® 2000 SP4

Windows® XP Home/Professional

Vista
Computer

Pentium processor of at least 400 MHz or equivalent

128 MB RAM

Graphics resolution of at least 1,024 x 768

Unused hard drive capacity of at least 15 MB

CD-ROM drive

USB interface

At least Internet Explorer 5.0.
Software
The P2A software must be purchased and installed separately from the
transmitter. If it is a new software version, the transmitter is already
supported completely. Older P2A software versions can be updated via the
P2A software upgrade (cf. product CD included with the transmitter).
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3.1.3

Scope of delivery

Included in the scope of delivery are:



P2A software
USB driver
When working with the parameterizing, adjusting and
analyzing software (P2A software), previous knowledge of
Windows® operating systems is assumed.
The description in this instruction manual relates to
Windows® XP.

3.2 First steps
3.2.1

Installing the software/driver
Administrator rights are required to install programs and
drivers under Windows® 2000 SP4, XP and Vista.

3.2.1.1
1
2
3

Installing P2A software

Insert CD with P2A software. If the installation program does not start
automatically:
Open Windows Explorer and start the file Setup.exe on the product
CD.
Follow the directions of the installation assistant.

3.2.1.2

Installing USB driver
Before installing the USB driver, please read the separate
documentation that is enclosed with the USB driver CD.

3.2.1.3
1

2

P2A software upgrade

Insert product CD (supplied with the transmitter).
Open Windows® Explorer and start the file P2A upgrade.exe on the
product CD.
Follow the directions of the installation assistant.
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3.2.2
3.2.2.1

▪

Starting the software
Starting the program

Select: [Start] > All Programs > Testo > P2A Software.
The program window is opened (see chapter 3.3.1, User interface,
page 117).

3.2.2.2

Establishing a connection with the instrument

Multiple instruments can be attached, however only one connection is active
at all times.



USB driver is installed (see chapter 3.2.1, Installing the
software/driver, page 115).

1
2

Start the P2A software.
Connect adapter (supplied with the P2A software) to the service
interface of the instrument (see volume 1, chapter 1.2.4, Service
interface, page 13).
Connect instrument/adapter to the PC via the USB interface.
The instrument file of the attached instrument is shown in the file list.

3

3.2.2.3

▪

Activating the connection with the instrument

Click on the desired instrument file.
The selected file is marked in colour and the connection with the
instrument is activated.
If a connection with the instrument is established when the program is
started, the corresponding instrument file is marked automatically.
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3.3 Using the software
3.3.1

User interface

1
2
3
4

5

6
1

Menu bar:
Menu

Command

Explanation

File

Open

Shows the Windows dialogue for searching and
opening files.

Save as

Saves the parameters of an instrument or
parameter file under a new name.

Copy

Copies the parameters of the marked instrument
or parameter file in the cache.

Paste

Pastes the parameters from the cache in the
marked instrument or parameter file.

View

Toolbar
Status bar

Activates/deactivates the toolbar or status bar.

?

Check
instrument
connections

Checks the connections to a connected
instrument without the instrument having to be
activated.

Edit
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Menu

Command

Explanation

Service

A text file with the most important information on
the computer and the software is opened via
Display service data.

About

Shows the version number of the P2A software.

2

Toolbar:
Shows the Windows-compliant icons for editing.
3 File list:
Icon

4

File

Explanation

Instrument
file

Instrument file
Connection to the instrument has been established.
<Type> <Serial number>.cfm
File name should not be changed.

Instrument
file

Instrument file
Connection to the instrument has not been
established.

Parameter
file

<Type> <Serial number> <Date> <Time>.cfp
File name can be changed.
The name can be selected freely, but it is
recommended that you retain the reference to the
instrument.
Parameter files are always marked red; the parameter
values they contain are only forwarded to the
instrument after being transmitted to the instrument
file.

Function buttons:
[Change parameterization] see chapter 3.3.2, page 119
[Test/analyze transmitter] see chapter 3.3.3, page 132
[Adjust transmitter] see chapter 3.3.4, page 137
[Transmitter history] see chapter 3.3.5, page 142
Dialogues on editing and testing the instrument are opened by means of
the buttons.
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5

6

File information:
Status

Shown in the window

Instrument file is
selected

Type, serial number, firmware version of the
instrument or probe.

Parameter file is
selected

Type, serial number and firmware version of
instrument for which the parameter file was
created.

Connection status

Green = connection is active,
Red = connection is inactive.

Status bar:
Shows the current status when editing via the menu bar.

3.3.2

Editing instrument/parameter file

3.3.2.1
Changing instrument/parameter file

The desired instrument/parameter file is marked.
1

Click on [Change parameterization].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Change parameterization register.
If the parameters were transmitted from other parameter files into the
instrument file, a message is shown with which you can transmit the
new parameters to the connected instrument using [Yes].
If the parameters should not be transmitted, click on [No].

2

Change or enter parameters in the corresponding fields.
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Unit/analog output

Explanation
All analog outputs are parameterized in this mask.

Unit/analog output
(graphic)

Unit: 0 to 1 V/5 V/10 V or 4 to 20 mA.
Vertical: Current version of the analog output.
Horizontal: Min./max. scale end points of selected unit.
The curve changes in accordance with the entered value
of scale minimum and maximum.

Scale minimum/
maximum

The endpoints of the scaling can be selected up to the
stored scale minimum and maximum. In the process,
scaling can take place beyond the measuring range in
order to adjust the analog output to the customer system.
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Field

Explanation

Unit

Selection of the physical unit.
When changing the unit, standard values are set for scale
minimum and maximum (see transmitter instruction
manual for the scale final values).
Caution!
When changing the phys. unit, the relay limit values are
set to the assigned default values.

Signal delay (graphic)

Curve changes according to the set signal delay.

Signal delay

Time interval in stages of 1 to 15:
1 = no delay
15 = longest delay.
The signal delay is added to the reaction time of the
sensor. The signal delay shows averaging over the time
interval of the selected stage in seconds:
Example
Stage 10 = average of the readings from the last 10
seconds.
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Relay limit values 1
to 4

Explanation
In this mask, the relay is parameterized (if this transmitter
option is available).

Only have the transmitter wired and connected by
authorized personnel with the voltage disconnected.

Relay x

Four relays are available (optional).

Not used

Relay is not used.
Hysteresis image and input options are hidden.

Collective alarm

A relay can be used as a collective alarm detector in the
event that selected messages appear. See below for
selection of the messages.
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Field

Explanation

MIN monitoring

Switched to ON below the limit value;
switched to OFF when, following this, Limit value and
Hysteresis are exceeded.

MAX monitoring

Switched to ON above the limit value;
switched to OFF when, following this, Limit value and
Hysteresis are undershot.

Hysteresis

To avoid switching cycles.

Channel

Selection of the channel that is to be monitored.

Limit value

Values for the limits of the unit selected in Unit/analog
output; 1 decimal place.
When changing the phys. unit, the relay limit values are
set to the default values.
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Collective alarm

Explanation
Selection of the messages (error, etc.) that should result
in a collective alarm (or linkage).

List field with
checkboxes

Selection of which messages generated in the transmitter
should be signalled as the collective alarm via the
corresponding relay.
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Basic settings

Explanation
Setting the absolute pressure

Absolute pressure

The absolute pressure is included in the calculation of the
following units:
- °Ctd or °Ftd
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Ethernet

Explanation
Networking the transmitters via Ethernet. For a multitude
of applications, measurement data can be simultaneously
recorded, documented and visualized.

Start wizard...

Address allocation for testo 6651 with Ethernet module
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IP address

Transmitter IP address
Before the automatic allocation of the IP address, the
network cable must be connected to the transmitter (see
Vol 1, Chap. 1.3.4.4, Page 36).
If the instrument is being used as a Saveris participant:



Saveris Base must be functional.
Saveris-Base must be connected to the network.

IP address of the
device

Address allocation for testo 6651 with Ethernet module

Manual

-

Define IP address of the transmitter
Enter netmask
- Enter gateway
-

Automatic

Automatic allocation of the IP address
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IP address

Saveris base IP address
Only when using the transmitter Ethernet modules in
Saveris mode

IP address of the base Address allocation of the Saveris base.
Manual

Take IP address from the menu window “InfoBase” of
the Saveris base
- Enter IP address
-
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Display

Explanation
Setting the display functions (if a display is available on
the transmitter).

Continuous display
lighting

Display lighting is permanently switched on.

Display lighting when
button is pressed (10
seconds)

When a particular button on the instrument is pressed, the
display lights up for 10 seconds.

Display brightness (0
to 9)

Setting the brightness between 0 and 9:
0 = dark
9 = light.

Display contrast
(0 to 9)

Setting the contrast between 0 and 9:
0 = lower contrast
9 = higher contrast.
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Field

Explanation

Display language

Selection of the language.

New password

The password consists of four numbers, each of which
must be between 1 and 9.
If the password protection is not to be used, the numerical
code "0000" must be entered.

Adopt new password

Button for confirming the new password.

Valid password

Display of the current password.

3.3.2.2

Saving parameters

Parameters can be saved in new parameter files.
1

Mark instrument/parameter file

2
3

Click on File > Save as in the menu bar.
Select storage location and enter the file name.

4

Click on [Save].
The new parameter file is shown in the file list.
Only the parameters are saved from an instrument file, the history data
are not adopted.
The original name (Instrument type, Serial number) is
suggested with the current date/time as standard, e.g.
"testo 6651 01234578 061120 1403.cfp".
For a standard installation, the files are saved under
"C:\Documents and Settings\All Users\Shared
Documents\P2A Software". The path can differ depending on
the version of the operating system.
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3.3.2.3

Open parameter file

All parameter files stored in the standard directory path are automatically
displayed in the file list when the software is started.
You can also open parameter files that are stored in other directories.
1
2
3

Click on File > Open in the menu bar.
Select the storage location and click on the requisite file.
Click on [Open].
The selected file is opened. This can be changed and saved (see
chapter 3.3.2.2, page 130).

3.3.2.4

Copying and pasting parameters

The parameters of a parameter file can be transmitted to an instrument file or
another parameter file from the same instrument type.
1
2
3
4

Select file whose parameters are to be copied.
Click on Edit > Copy in the menu bar.
Select the file which is to be modified.
Click on Edit > Paste in the menu bar.
The parameters are transmitted to the file.
You can also use the common keyboard shortcuts for
copying and pasting, i.e. CTRL C and CTRL V.
Parameters can also be transmitted using drag & drop, where
you drag the icon of the parameter file onto the icon of the
target instrument file.

3.3.2.5

Deleting instrument/parameter file

Instrument/parameter files can be deleted from the file list.
1
2

Click on the file that is to be deleted with the right mouse button.
Select the command Delete in the context menu.
The instrument or parameter file is deleted from the list.
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3.3.3

Analyzing/testing the transmitter

In this section, you can test the outputs of the connected instrument, read off
the limit values and reset the parameters to the factory settings.
The function is only available for instrument files.

3.3.3.1
Analyzing/testing the instrument

The required instrument file is marked.
1

Click on [Test/analyze transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

2

Perform action:

3

Action

Explanation

Carry out factory
reset:

Reset the unit, limit value and hysteresis parameters to
factory settings (see chapter 3.3.3.2, page 132).

Test analog
output:

Test channel 1/2.

Test switch
outputs:

Manually switch relays 1 to 4 to test for proper function
(see chapter 3.3.3.3, page 133).

Min./max. values
display:

Overview of the minimum and maximum values
measured since the last reset of the transmitter (see
chapter 3.3.3.5, page 136).

Click on [OK] or [Cancel] to close the dialogue.

3.3.3.2
Carry out factory reset

The required instrument file is marked.
1

Click on [Test/analyze transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

2

Mark Transmitter test.
Current operating hours are shown.

3

Confirm control query to perform the reset.
The values are reset to the default settings.

4

Click on [OK] or [Cancel] to close the dialogue.
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3.3.3.3
Test analog output channel 1 / 2 / 3
The desired instrument file is highlighted.

1

Click on [Test/analyze transmitter].
The dialog Properties of <Instrument type> <Serial number> is
opened with the tab Test/analyze transmitter.

2

Highlight channel and test value.
Field / button

Explanation
Testing analog outputs (see Volume 1, Chapter 1.4.6.5,
Page 69).

Actual reading

Measurement value is refreshed every second

Unit

Unit according to the respective analog output type.

Pre-set value

Freely definable output value for the respective analog
output type /V or mA), 1 decimal place.
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3

[Activate]

Clicking forwards the pre-set value entered to the
respective analog output and to the test contacts.
A warning indicates that if wired, the value will be
transferred to the connected instruments .
Now test the analog output using an accurate multimeter.

[Deactivate]

Ends connection of electrical parameter to analog output.
The analog output returns to current measurement
value.

To close the dialog, click on [OK] or [Cancel].
The analog output returns to measurement mode.
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3.3.3.4
Testing switch output relays 1 to 4
The required instrument file is marked.

1

Click on [Test/analyze transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

2

Mark Relay tests and test the values.

Field/button

Explanation
Check the relay function (see volume 1, chapter 1.4.6.6,
page 71).

[Activate relay n]

Close contact.
A warning informs that the value is being transmitted to a
connected PLC, external display, etc. in the event of
existing cabling.

[Deactivate relay n]

Open contact.
A warning informs that the value is being transmitted to a
connected PLC, external display, etc. in the event of
existing cabling.

3

Click on [OK] or [Cancel] to close the dialogue.
The analog output returns to Measuring Mode again.
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3.3.3.5

Displaying min./max. values

The transmitter saves the minimum or maximum value for each channel
(measured since the last voltage supply or since the last manual reset).



The required instrument file is marked.

1

Click on [Test/analyze transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Test/analyze transmitter register.

2

Mark Min./max. values.

Field/button

Explanation
View the min./max. values of each channel.

Channel

Min./max. of channel 1/2

Value

Min. or max. value, 1 decimal place.

Unit

Unit selected in Unit/analog output.

3

Reset Min./max. values.

6

Click on [Reset the min./max. values].
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7

Confirm control query to perform the reset.
The values are reset to the default settings.

8

Click on [OK] or [Cancel] to close the dialogue.

3.3.4 Adjusting the transmitter
This function is used to adjust an attached instrument. The following
adjustments may be carried out using the software:




1-point adjustment (offset)
2-point adjustment (upper and lower adjustment point)
Analog adjustment (entry via assistant/wizard).

See also volume 1, chapter 1.3.5 Adjusting the instrument, page 53).

3.3.4.1

1-point adjustment
The testo 400/650 with precision humidity probe (order no.
0636 9741) is recommended as the reference measuring
instrument for 1-point adjustment (offset) (see volume 1,
chapter 1.3.5.2, page 55).

1

2
3

4
5

Expose the reference measuring instrument and the instrument to be
adjusted to the same constant conditions and wait for equalization
period to lapse.
Mark the instrument file of the connected instrument.
Click on [Adjusting the transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Adjusting the transmitter register.
Enter reference value and click on [Carry out 1-point adjustment].
Confirm confirmation request.
The adjustment is carried out.
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Field

Explanation

°C/°F

Selection of the unit; only for temperature adjustment.

Actual reading

Reading in °C/°F or % RH.
Readings are updated every second.

Reference value

Entry of the read-off value from the reference measuring
instrument.
Permissible entries:
- max. 5 % RH deviation (sum of all 1-point adjustments)
- max. 2 K (°C) deviation (sum of all 1-point adjustments)

▪
6

Click on [Set offset to zero] to reset a transmitted reference value.
The current reading is used again.
Click on [OK] or [Cancel] to close the dialogue.
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3.3.4.2

2-point adjustment
Also see volume 1, chapter 1.3.5.3, page 57.

1

2
3

Expose the reference measuring instrument and the instrument to be
adjusted to the same constant conditions and wait for equalization
period to lapse.
Mark the instrument file of the connected instrument.
Click on [Adjusting the transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Adjusting the transmitter register.

4

Mark 11.3 %, enter the reference value for the lower adjustment point
and click on [Lower adjustment point].
The adjustment is carried out.

5

Mark 75.3 %, enter the reference value for the upper adjustment point
and click on [Upper adjustment point].
The adjustment is carried out.
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6

Field

Explanation

Actual reading

Reading in % RH.
Readings are updated every second.

Reference
value

Entry of the read-off value from the reference measuring
instrument.
Permissible entries:
- Lower adjustment point 10.3 to 12.3 % RH
- Upper adjustment point 74.3 to 76.3 % RH.

Click on [OK] or [Cancel] to close the dialogue.
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3.3.4.3
1
2
3

4

Adjusting the analog output

Connect precision multimeter (see volume 1, chapter 1.3.5.4, page
59).
Mark the instrument file of the connected instrument.
Click on [Adjusting the transmitter].
The Properties of <Instrument type> <Serial number> dialogue is
opened with the Adjusting the transmitter register.
Click on [Start wizard…] and follow the instructions of the wizard.
The adjustment is performed when the wizard is closed.
Field

Explanation

Default value

The analog output value is given at the output:

Measured
analog value

-

Lower adjustment point: 10% of the max. value

-

Centre adjustment point: 50% of the max. value

-

Upper adjustment point: 90 % of the max. value.

Required field:
Entry of the value read off at the multimeter.
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3.3.5

Transmitter history

Parameterizations, adjustment processes and messages that have occurred
are registered in the transmitter with an operating hours stamp.
In the history overviews (explained later in more detail), past processes and
events can be made visible.
For parameter changes or adjustments that are performed
directly at the instrument (via the user menu), "Transmitter" is
entered in the User field and only the operating hour is
entered in the Date/time field instead of operating
hour/date/time.
For entries that are performed using the P2A software, the
name of the user logged into Windows appears in the User
field, while the operating hour is shown in the Date/time field.
1
2

Mark the instrument file of the connected instrument.
Click on [Transmitter history] button.
The "Properties of <Instrument type> <Serial number>" dialogue is
opened with the Transmitter history register.

3

Click on the required entry in the list to change the display.
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Field

Explanation

Operating
hours/date/time

Operating hour/time stamp at which the change at the
instrument was performed.

User

Name with which the user is logged into the operating
system.
"MUF" (= transmitter) if the change was performed at the
instrument.

Comments

Type of parameter change,
e.g. "Unit of channel 2 from °F to °C".
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Field

Explanation

Selection: 1-point adjustments/2-point adjustments/Analog adjustments.
Operating
hours/date/time

Operating hour/time stamp at which the change at the
instrument was performed.

User

Name with which the user is logged into the operating
system.
"MUF" (= transmitter) if the change was performed at the
instrument.

Serial no. probe

Serial number of the probe.

Reference value

If no changes were performed, no value is displayed.

Actual value before
adjustment

1-point adjustment: If no changes were performed, no
value is displayed.

Unit

Unit during the adjustment.
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Field

Explanation

Offset from

1-point adjustment: Value before the adjustment.

Offset to

1-point adjustment: Value after the adjustment.

Offset

2-point adjustment: Difference between target and actual
value reported by instrument.

Channel

Analog adjustment: Channel 1 to n.

Specification

Analog adjustment: Actual value.

Reading

Analog adjustment: Reference value entered.

Offset

Analog adjustment: Deviation at time of adjustment.
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Field

Explanation

The table is shown only for error and status messages that were generated in the
transmitter and have been saved.
Operating hours

Operating hour at which the message appeared in the
instrument.

User

"MUF" (= transmitter) because the message was
generated in the transmitter.

Message

e.g. "Wrong probe". A non-compatible probe was
connected.

Type of message

e.g. early warning, status message.

testo 6600 - 3.3 Using the software 147

▪

To print out the history data, click on [Print].
The printing job is automatically sent to the default printer for
the operating system.
The printout can be edited using [Set up printer…].
This button is not working; the print command offers no
selection of the printer.

4

Click on [OK] or [Cancel] to close the dialogue.
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4

Tips and assistance

4.1 Questions and answers
Question

Possible causes/solutions

Connection to instrument cannot be
established

Check connection cable/plug contacts

A message appears on the display

See volume 1, chapter 1.5, page 76

Malfunction (with or without display)

Analysis using the P2A software (see
chapter 3, page 113).

Undo adjustment

A 1-point temperature/humidity adjustment
can be reset to the current reading using
[Set offset to zero].
The actual values before the adjustment
can be read out from the corresponding
history table.
2-point adjustments and analog
adjustments can only be undone by
means of a factory reset.

When does a stable current reading
appear?

After approx. 20 seconds

If we could not answer your question, please contact your dealer or Testo
Customer Service. For contact data, see back of this document or web page
www.testo.com/service-contact
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4.2 Accessories and spare parts
An overview of the probes that can be used with the
testo 6651 can be found in volume 1, chapter 1.2.2, page 12.

Designation

Article no.

Interface and software
P2A software (parameterizing, adjusting, analyzing) incl. USB
adapter

0554 6020

testo 400/650 adapter

0554 6022

Fastenings, assembly aids
Wall/duct bracket with M3 screw for fastening the transmitter to the
probe and the probe to the wall/duct

0554 6651

Single-hole plastic duct screw connection

0554 1793

Duct screw connection (aluminium/PVC)

0554 1794

Pressure-tight G 1/2" screw connection with cutting ring up to 16 bar

0554 1795

Pressure-tight G 1/2" screw connection with PTFE ring up to 6 bar

0554 1796

Plug-in connections
Set of M12 plug-in connections (connector and socket) for power
and signal lines

0554 6682

Sensor filters and protective caps
PTFE protective cap

0554 9913

Stainless steel sintered filter

0554 0647

Wire mesh filter

0554 0757

Sintered PTFE filter

0554 0759

Protection cap made of metal (open)

0554 0755

Plastic protection cap (open)

0192 0265

Condensation protection

0554 0166

Adjustment equipment
Salt pots (11.3/75.3 % RH adjustment set)
Reference set (testo 650, 1 % RH probe with certificate)
Adjustment adapter (for 1-point adjustment with testo 400 or testo
650

0554 0660
0699 3556/20
0554 6022
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Designation

Article no.

Ethernet
Ethernet module for installation by customer

0554 6656

Ethernet plug

0554 6653

Supply
Mains unit (desktop, wall-mounted)

0554 1748

Mains unit (top-hat rail mounting)

0554 1749

External display
Prozess display testo 54-2 AC....

5400 7553

Prozess display testo 54-7 AC....

5400 7555

Calibration
Standard ISO calibration certificate, transmitter only

0520 1000

Standard DAkkS calibration certificate, transmitter only

0520 1200

Standard ISO calibration certificate, transmitter + probes

0520 0176

Special ISO calibration certificate, transmitter + probes

0520 0066

Standard DAkkS calibration certificate, transmitter + probes

0520 0276

Special DAkkS calibration certificate, transmitter + probes

0520 0236

DAkkS calibration certificate temperature, probes

0520 0261
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4.2.1 Ordering options for testo 6651 transmitter
(0555 6651)
Order code

Characteristic

Axx Version
A01

0555 6651

Bxx Analog
output
B01

4 to 20 mA (2-wire, 24 VDC) (not with relay or Ethernet
module)1

B02

0 to 1 V (4-wire, 24 VAC/DC)

B03

0 to 5 V (4-wire, 24 VAC/DC)

B04

0 to 10 V (4-wire, 24 VAC/DC)

B05

0 to 20 mA (4-wire, 24 VAC/DC)

B06

4 to 20 mA (4-wire, 24 VAC/DC)

Cxx Display
C00

without display

C02

with display/English

C03

with display/German

C04

with display/French

C05

with display/Spanish

C06

with display/Italian

C07

with display/Japanese

Dxx Cable entry
D01

M16 PG screw connection (with relay, also M20)

D02

Cable entry NPT 1/2"

D03

Plug-in connections for power and signal lines

Exx Ethernet
module
E00

without Ethernet module

E01

with Ethernet module

Fxx
Channel 1 Unit
F01

1

% RH/Min/Max

In this option, the display ilumination cannot be switched on
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Order code

Characteristic

F02

°C/Min/Max

F03

°F/Min/Max

F04

°Ctd/Min/Max

F05

°Ftd/Min/Max

Gxx
Channel 2 Unit
G01

% RH/Min/Max

G02

°C/Min/Max

G03

°F/Min/Max

G04

°Ctd/Min/Max

G05

°Ftd/Min/Max

Hxx Relay
H00

without relay

H01

4 relay outputs, limit value monitoring

H02

4 relay outputs, channel 1 limit values and collective alarm
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4.2.2 Ordering options for testo 6600 probes (0555
6600)
Order code

Characteristic

Lxx Probe type
L 01

Probe 6601

L 02

Probe 6602

L 03

Probe 6603

L 04

Probe 6604

L 05

Probe 6605

Mxx Protective
filter
M 01

Stainless steel sintered filter

M 02

Metal wire protection cap

M 03

Sintered PTFE filter

M 04

Open metal protection cap

M 05

ABS plastic cap (open)

Nxx Cable length
N 00

Without cable (testo 6601)

N 01

1 m cable length (testo 6604, 6605)

N 02

2 m cable length (testo 6604, 6605)

N 05

5 m cable length (testo 6605)

N 23

Cable length specifically for duct versions (testo 6602, 6603)

Pxx Probe length
P 07

Probe length approx. 70 mm (testo 6601)

P 14

Probe length approx. 140 mm (testo 6604)

P 20

Probe length approx. 200 mm (testo 6601, 6605)

P 28

Probe length approx. 280 mm (testo 6602, 6603, 6604)

P 50

Probe length approx. 500 mm (testo 6605)
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